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1.0 INTRODUCTION 
 
The Elite PI Designer program is used to design displays for use with an 
Elite PI. With this tool, you can customize your displays with special 
features and graphics, and update your displays whenever necessary. 
The layout files, which are created, can be transferred to Elite PI 
Display for use.   
 
1.1 Getting Started 
Minimum System Requirements: 
• Microsoft Windows © 95 or Microsoft Windows © 98, Microsoft 

Windows © 2000, or Microsoft Windows NT © Workstation 
• Pentium 100 processor 
• 16 MB memory for Windows 
• 20 MB available hard drive space 
• 800 x 600 point resolution and 16-bit color (800 x 600 or higher) 

desktop area (video resolution) and High Color (16 bit or better) video 
mode. 

 
1.2 Installation 
1. Place the Elite PI CD in the CD-ROM drive. 
2. The program will automatically start up install after you have 

inserted the CD.  
3. If the setup program does not automatically start, go to the Start 

bar and select Run. Type in the drive letter of the installation disk, 
and the file name “setup.exe”. For example, if the CD is in the d: 
drive, type d:\setup.exe and select OK. This will begin the 
installation process.   

4. The Installation Wizard will guide you through the installation 
process. The installation process will create an Elite PI application 
folder under your Programs of your Start Bar. To start the 
application, simply access the folder and select Elite PI Designer. 

 
 
 
2.0 DESIGNING AND EDITING A LAYOUT 
 
Elite PI Designer contains many tools to help you build the perfect 
layout for your system. Your display can contain the following elements: 

• A customized background 
• Floor position  
• Direction display 



• Message displays based on Priority, Floor, and Scheduled 
messages 

• Time display 
• Temperature display 
• Stock ticker display 

 
In addition, you configure your display based upon the amount of floors 
you have for your elevator bank.  
 
When you first open Elite PI Designer, you will be in Design mode for a 
new Layout (Figure 1). Although you do not need to follow a particular 
order when designing you Layout, we will take you through the design of 
a new layout, using the tools described above. We will start by defining 
your background, and place various display elements into your Layout. 
 

 
Figure 1 
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2.1 Unlock the Display Element Position  
Before you begin designing your Layout, you need to make sure that 
the layout is not “locked.” This is determined by the position of the 
button with a padlock on it. This button is the Lock button, and 
controls if the Display elements can be moved and resized. When the 
Elite PI Designer is initially opened, this button defaults to the 

Unlocked (up) position . When the button is in the Unlocked (up) 
position, elements can be edited, added, moved, or deleted. When a file 

is loaded, this button defaults to the Locked (down) position . If a 
screen is locked, elements can be edited, but items cannot be added, 
moved, or deleted. 
 
2.2 Select a Background 
To begin, select a background for your Layout. Click on the right-most 
button on the toolbar to select a graphic. This will bring up an Open 
Background window, containing backgrounds developed for use with 
Elite PI Designer (Figure 2). 
 

 
Figure 2 

To view a file, click once on the file name with the mouse, and it will 
appear in the box on the right. To select a file, either double-click on 
the filename, or single-click on the filename and select the Open 
button. Any bitmap type files (files with an extension of .bmp) may be 
used. Enhanced metafiles (files with an extension of .emf) and metafiles 
(files with an extension of .wmf) can also be used. If you would like to 
select a file other than the default backgrounds provided, simply select 
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the directory where your bitmap file resides, and select the background 
you want. The file selected will be resized to fit on the layout in a 600 x 
480 mode. Depending on your screen resolution, the background may 
not fill your entire screen.  

2.3 Design your Layout 
You will now place Display Elements on your screen. You may place 
multiple display elements of the same type on your screen, and you 
need not place all Display Elements on your screen. Although you have 
many different display elements to use in your Layout, they are added 
and edited in very similar ways.  
 
To add an element to the screen, click on the button for the element 
and position the mouse over the layout area where you would like the 
element to be displayed, and click the left button to add the item to 
the screen. A dashed box will appear, which can be moved, resized and 
edited.   

To move the item, simply select the box by single-clicking on it, and 
drag the box where it should be.   

To resize the item, select the box, move the cursor to one of the 
edges of the box until the bi-directional pointer appears, and then drag 
the edge of the box to resize. 

To edit most elements, you have two options: you may either select 
the element and then double-click, which will open up the editing 
screen, or right click on the element, and select Edit from the pop up 
menu. For the priority, scheduled, and floor based messages, however, 
you must right click on the item to edit the element. 
 



 
Figure 3 
 
Shown in Figure 3 is an example of an “Editing Box”. The buttons at the 
top of the window are common to most Display Element editing. They 
effect the text being displayed, and are illustrated for you in the box in 
the middle of the screen. From top to bottom, left to right, they 
perform the following functions. 
 
First row

Font Name: The font which is used for the text. To select from  
 various fonts, click on the arrow ( ) which will display a 

drop-down list of the font styles. 
 
Font Size: The point size of the font for the text. To select this 
 item, you may either select from the drop-down list by 

clicking on the arrow ( ), or enter the font size you 
would like. 

 
Font Color: The color of the font used for the text. Selecting this 

button will bring up a box from which you may select 
pre-defined colors, or define a custom color. 
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Bold:  Applies or removes bold formatting to the text. 
 
 
 
Italic:  Applies or removes italic formatting to the text. 
 
 
 
Underline:  Applies or removes underline formatting to the text. 

 
Align Left:  Aligns all text flush with the left margin. 
 
 
 
Align Center: Centers the text between the left and right margins. 
 
 
 
Align Right: Aligns all text flush with the right margin. 
 
 
 
Cut: Will remove text from the area, and place text to the 

clipboard for “pasting”. 
 
 
Copy:  Will leave text in the area, and place the selected text 

to the clipboard for “pasting”. 
 

 
Paste: Will place text that was moved to the clipboard 

wherever the cursor is located. 
 
 

Insert Image: Allows for a picture to be inserted instead of typing in 
text. 

 
 

OK (check): Saves the changes made to the Display element and 
closes the edit window. You may save your work here, 
or use the File menu. 
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Controls on rows 2 and 3 are used to control the 3-D effects that can 
be given to the text. Row 2 controls the highlight, which is a light 
shadow drawn behind the text. Row 3 controls the shadow, which is a 
dark shadow drawn behind the text. 

 

Second Row 

Highlight Direction: The direction which the highlight is drawn 
behind the text. 

 

 Highlight Style:     How the highlight is drawn behind the text. 

 

 

Highlight Depth: How far back the highlight is drawn behind the 
text. 

 

Highlight Color: This opens a Color dialog letting the user 
choose the color of the highlight. 

 

 

Third Row

Shadow Direction:  The direction which the shadow is drawn behind  
 the text. 

 

Shadow Style: How the shadow is drawn behind the text. 

 

 

Shadow Depth:  How far back the shadow is drawn behind the 
text. 

 

Shadow Color: This opens a Color dialog letting the user choose 
the color of the shadow. 
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The center area of the Edit screen shows the text or image as it will 
appear on the Layout. You can preview all your changes using this area.  

The bottom part of the screen is different for each of the display 
elements. 

We will go through the Display Elements in detail in the order they 
appear on the toolbar (Figure 4). 

 

Figure 4 

2.3.1 Pointer   

The pointer is the red arrow button to the right of the Lock button.  
This button is selected (down) if you have not selected an element.   

2.3.2  Time Display Element   

This button, with the picture of a clock, is used to add a Time and/or 
Date display element to a layout. Add the element using the 
instructions above. Then, choose either method listed above to edit the 
display. This will bring up the Time Display Edit Screen (Figure 5).   
 

 
Figure 5 
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The menu bar at the top of this screen has fewer items for the Time 
Display Element than for the other elements, but the file menu is 
common to all elements. The file menu gives you an option to save and 
exit, or simply to exit.  

On the bottom part of the screen there are two drop-down boxes 
providing different options for displaying the time and date. You may 
leave either box blank if you are only interested in a one-line display. 

In the lower right corner of the screen is a customize button for each 
of the lines at the bottom of the screen. The customize button allows 
you to type in text and allows for the date and time to be formatted 
differently. Table 1 shows the date and time specifiers that can be 
used when the customize button is selected. 
 
 
Specifier Displays 
am/pm Uses the 12-hour clock for the preceding h or hh  
 specifier, and displays ‘am’ for any hour before noon, and  
 ‘pm’ for any hour after noon. The am/pm specifier can  
 Use lower, upper, or mixed case, and the result is  
 displayed accordingly. 
 
a/p Uses the 12-hour clock for the preceding h or hh  
 specifier, and displays ‘a’ for any hour before noon, and 
 ‘p’ for any hour after noon. The a/p specifier can use  
 lower, upper, or mixed case, and the result is displayed  
 accordingly. 
 
d Displays the day as a number without a leading zero (1-31). 
 
h Displays the hour without a leading zero (0-23). 
 
hh Displays the hour with a leading zero (00-23).  
 
m Displays the month as a number without a leading zero (1- 
 12). If the m specifier immediately follows an h or hh  
 specifier, the minute rather than the month is displayed. 
 
mm Displays the month as a number with a leading zero (01-12). 
 If the mm specifier immediately follows an h or hh specifier,  
 the minute rather than the month is displayed. 
 
n Displays the minute without a leading zero (0-59). 
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nn Displays the minute with a leading zero (00-59). 
 
s Displays the second without a leading zero (0-59). 
 
ss Displays the second with a leading zero (00-59). 
 
yy Displays the year as a two-digit number (00-99). 
 
yyyy Displays the year as a four-digit number (0000-9999). 
 
“xx” Characters enclosed in double quotes are displayed as-is,  
 and do not affect formatting. 
 
2.3.3 Priority, Floor, and Scheduled Messages 
The display element for Priority, Floor, and Scheduled messages is 
different from the other display elements because it has three different 
edit screens associated with it. Add this element using the 
instructions above, and to edit it, right click on it, and choose to edit 
the priority, landing, or scheduled messages.  
 
Priority messages are messages concerning elevator operation, such 
as door opening and closing, independent service, and fire service 
messages. When editing the priority messages, an edit screen appears 
which is similar to the Time Edit screen. There are some new menus 
and new items available for this screen which are similar to Figure 3. 
The cut, copy and paste options are still available as in most other 
Windows applications, and there are also buttons on the screen for 
these functions. Cut and copy will copy all aspects of the item, 
including any images and text associated with the item. You may wish 
to use the “Fill” feature for Priority and Landing messages. In order to 
obtain the following screen right click once on the box and select Edit 
Priority Messages. Once you have the Priority Message Edit screen 
the click on Edit and then select Fill and the following screen will appear 
(Figure 6). Selecting the Fill option will bring up a window asking you for 
“Range Fill data”.  



 
Figure 6 
 
Here you will type the pattern for your floor layout. For example, if you 
had floors 1 through 6, an express floor, and then floors 35 through 
50, you would type “1-6, x, 35-50” (assuming you use the character x 
to reference the express). This will make data entry much faster. Fill will 
start from the Priority Number you have selected, so take note of the 
priority number before filling in the data. 

 
The next item on the menu bar is Insert. This allows you to insert a 
picture instead of typing in text. There is also a button for this 
function, the second button from the right, with a camera. 

 
Figure 7 

 
After choosing to insert a picture, the insert picture screen (Figure 7) 
will appear. Six default messages are included with the Elite PI 

 - 13 -



 - 14 -

Designer, which can be found under the directory Images\Priority 
Messages. Other images can also be inserted. 

 
The next menu on the menu bar is Item. This allows you to scroll up and 
down between items. You may also do this using the Priority Number 
Box referenced below on the right-hand side of the screen. Help is the 
last item on the menu bar. 

 
The items at the top of the window (Figure 3) affect the font, the 
highlight, and the shadow. There are cut, copy and paste buttons 
added to the top line. There is another additional item in the top bar for 
this screen: the Priority Number box. For priority messages, there 
are 63 available items. You need to set up your priority messages to 
correspond with the signal being sent from your controller. To edit the 
priority messages, select the item number for the message you would 
like to appear. In the white space at the bottom of the screen, type in 
the text you wish to appear as the message. If you have a file 
containing a graphic you would like to insert as the message, you can 
either select Insert Image from the menu, or press the button with the 
camera on it. This will prompt you to select the file you want to appear. 
Six default messages are included with the Elite PI Designer, which can 
be found under the directory Images\Priority Messages.   
 
Floor messages will display a message based upon the floor at which 
the elevator stops when the elevator door is open. Common usage of 
this message includes floor occupancy information and greetings for 
elevator occupants. The edit screen for landing messages is identical 
to the edit screen for priority messages, except the Floor box reflects 
the number of floors you have selected for this display. Type messages 
in the white space at the bottom of the screen for any floors selected 
at the top of the screen.   

 
Scheduled messages are messages which you want to have displayed 
during a certain day and certain time of day. The edit screen for 
scheduled messages (Figure 8) is similar to the screen for priority 
messages. 
 

 

 

 



 

Figure 8 
 
The items at the top of the window are the same, except that the 
Message Number box contains 150 available items for scheduled 
messages.   
 
You may assign up to four different time periods to each time message 
at the bottom of the screen. Each time period has a date range. The 
date range is composed of the Start time, End time, Start date, and 
End date for each individual time period. Within the date range specific 
days can be set (Sunday – Saturday) to show the scheduled messages.  
If there is more than one message to be displayed during a given day 
and time, the messages will alternate in a round robin fashion. The 
duration shows how many seconds each message is displayed before 
advancing to the next message. Each message can be displayed for up 
to 250 seconds before advancing. 
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Set As Valid will set the time period from the current date to a date 
20 years in the future, to be shown at all times. This is the default 
setting. Clear Time Period will clear the time period which you have 
entered. 

2.3.4 Floor position   
The next button on the toolbar represents the display element for floor 
position. Information concerning the floor number or level is displayed 
using this element. This element is added as described above, and can 
be edited using either method given. The edit screen for floor position 
is identical to the edit screen for landing messages. Select the floor in 
the upper-right hand corner, and type the applicable text into the 
white space at the bottom. This is another element where the use of 
the “fill” option on the Edit menu will make data entry easier. Again, if 
you would like to use an existing file or graphic, simply use the insert 
image option. 

2.3.5 Temperature display     
The thermometer button on the toolbar is the item representing the 
temperature display element. This element is similar to the Time display 
element, in that it does not change for different scan slots. Add a 
Temperature display element, and edit the element. 
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The edit screen for the temperature display (Figure 9) is the same at 
the top as for the Time display. At the bottom of the screen, you may 
select whether the temperature will be displayed in Celsius, Fahrenheit 
or follow the temperature from the Time/Temp unit. The Time/Temp unit 
can also be set with either Celsius or Fahrenheit. A sample value can 
be placed for viewing. The temperature in either temperature scale will 
come from the Temperature probe attached to the Time/Temp unit. 

2.3.6 Direction Display   

The direction display shows the direction of the elevator, and is based 
on the direction signals sent to the unit. To add this element, click on 
the button for the element and position the mouse over the layout area 
where you would like the element to be displayed. The edit screen for 
the direction display is different from the other element edit screens 
(Figure 10). You may place indicators for four different elevator states:  
Stationary, Down, Up, or Both. To select an image for any direction, 
double-click the mouse on the item, or right-click on the item and 
select Load. This will take you to an Open File screen, where you may 
select from the many icons provided with Elite PI Designer, or select 
graphics of your own design. Also on the edit screen is a box where you 
may enter scan slots where the direction display should not display any 
item. Finally, you may choose whether the direction display is to display 
traveling signals (the direction the elevator is going) or arrival signals 
(the direction the elevator will go next). If, after selecting a graphic, 
you would like to remove it, simply right-click on the image and select 

Figure 1

Clear. 

0 

 - 17 -



 - 18 -

ock Ticker Display
nt shows a scrolling line of text. This line 

o add this element you must first enable the Stock Ticker button. In 

2.3.7 St  
The stock ticker display eleme
of text is received by way of the line data serial port on the display. 
 
T
order to enable the button you must first click on Configuration setup 
in the top tool bar. Then select Design Setup which will give you a box 
labeled Floor List Configuration. Select the Advanced tab and you will 
then notice a list of Live Data Options. Under the Live Data Options 
you will notice that the Stock Ticker is not checked. Select the Stock
Ticker and make sure that the item is enabled (selected).   
 

 

ow that the Stock Ticker is enabled (the button is in the “up” 
use 

.  

he top row of the Stock Ticker Edit screen (Figure 11) has the same 

Second Row

N
position) click on the button for the element and position the mo
over the layout area where you would like the element to be displayed
This element is similar to the Time Display Element, in that it does not 
change for different scan slots, rather it follows the serial data 
received. 
 
T
functions as the other edit boxes.  The second row contains Delay, 
Step Size, Offset, and the Run/Stop Stock Ticker Button. 
 

 

This is the time in milliseconds between scrolling 

tep Size: This is the number of pixels the text is shifted 

ffset: This is the number of pixels the text is shifted 

un/Stop Stock: This runs/stops the scrolling of the text in the 

Delay: 
of text. Used to control the speed of scrolling. 

 
 
S

each time it is moved. It is used to control the 
speed of the scrolling. 

 
O

vertically. It is used to show two lines of text. 
 
 
R

Center area. 
 
 
 



 
Figure 11 

he center area of the Edit screen shows the text as it will appear on 

he bottom area is where you will type in your start up message. This 
 

.4 Accessing you Files 

 

T
the Layout. You can preview all of your changes using this area. 
 
T
text is shown when the serial link is down for a minute and for the first
30 seconds after the serial link starts. 
 
2

 

2.4.1 New   
To start a new design, select the File menu, and select New, or 

This select the New button, which is the first button on the toolbar. 
will clear the screen and allow you to begin designing a new Layout. If 
you have a Layout open when you request a New Layout, you will be 
prompted to save the open Layout. 
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2.4.2 Open   
To open a design you have previously saved, select the File menu, 
and select Open, or select the Open button, which is the second 
button on the toolbar. This will bring up an Open File screen, 
prompting you to select the file you wish to open. 

 
2.4.3 Collect for Transfer   
To select Collect for Transfer, select the File menu, and select 
Collect for Transfer. This will save the design and all supporting 
images to a file for later transfer to an Elite PI Display. The current 
work will be saved into the .epi file, and then you will be prompted 
with a Save As window. The filename will default to the current 
layout name with a .zip extension. Select the Open button to start 
the collection process, or cancel to exit. While the collection is 
being created, the bottom status bar will show the current file 
being added and a progress bar showing the percent complete. If a 
file cannot be found, the process will stop and an error message will 
be displayed. 

 
2.4.4 Close   
To close your current design, select the File menu, and select Close. 

2.4.5 Save   

To save your work, you can select the File menu, and select Save, or 
you can select the Save button, which is the third button on the 
toolbar. If you have already saved your file, selecting this function 
will save over your previous file. If you have not already saved your 
file, this function will bring up the Save As window (Figure 12).  
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 Figure 12 
 

2.4.6 Save As 
The Save As window will prompt you to enter a filename and path for 
your file. If you do not specify a directory, your layout will be saved 
under the last directory you have saved to. Your layout will be saved 
with an extension of .epi. 

 
 
3.0 ADVANCED EDITING 
 
There are tools included with Elite PI Designer to make the design of 
your layout simpler.   
 
3.1 Element properties 
Using the Properties box, you can specify the exact location of your 
item on the display, specify the height and width of an item on your 
display, or choose to center the item vertically or horizontally. To view 
the Properties box for an item, right-click on any item and select 
Properties. This will bring up the Properties box, pictured in Figure 13. 
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Figure 13                   Figure 14 
 
The Top box indicates how many pixels the top edge of the box is from 
the top of the layout. The Left box indicates how many pixels the left 
edge of the box is from the left side of the layout. The Height and 
Width boxes detail the size of the box in pixels. Selecting the Center 
Horz. Button will center your item horizontally on the screen, and 
selecting the Center Vert. Button will center your item vertically on 
the screen. If you want to ensure that two elements are the same 
size, you can check the height and width of the two boxes and edit 
their size. The Element Name is the name that will be shown for the 
element when Elements menu item is selected on the main screen.  
 
Using the Properties box, the background can be either copied to the 
clipboard or it can be saved to a file. Figure 14 shows the background 
options. 

Figure 15                      Figure 16 
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When the Car number under the Multi-car option is chosen (Figure 15), 
the program listens to the information coming from that particular car. 
 
When Ignore Door Signal is selected in Figure 16, the program acts as 
if the doors are always open. Thus, the operator always gets the floor 
messages and never the time messages. 
 
When the signal from the controller is backwards, the Invert Door 
Signal is chosen. 
 
3.2 Element Alignment 
If you want to align elements with each other, select one item by 
clicking on it. Then, hold down the Shift key and click on any other items 
that you wish to align. Selected elements will have a light gray box 
around them. Once your elements are selected, right click, and select 
Alignment. This will bring up a menu with options of aligning the tops, 
bottom, lefts, or centers of the items selected (Figure 16). Remember 
that the item selected first will be the “source” object, and will be the 
item to which the others are aligned.  
 

 
Figure 17  
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4.0 CONFIGURATION SETUP 
 

4.1 Design Setup 
The Floor List Configuration screen (Figure 18) appears when Design 
setup is chosen from the Configuration setup. If you have more than 
one car for your elevator, then you can choose which floors 
correspond with which car. Under Floor List, you enter the floors for 
that selected car. 
 

 
Figure 18 
 

 
Figure 19 
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4.2 Demo Properties 
 

    
Figure 20 

 
4.3 Simulated Time/ Date and Temp 

 

  
 Figure 21 
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4.4 Sample Data Entry 
 

  
 Figure 22 

 
 
 

5.0 TESTING YOUR LAYOUT 
 
Once your Layout is completed, you will want to test it to verify that it 
works as you expect.  
 

5.1 Layout state    
The Layout State button, to the left of the Lock button, controls if the 

display is in design view (down)  or run view (up) . In design 
view, all visible elements on the screen appear in a dashed box. In run 
view, an element will appear in a dashed box only if it is selected. While 
in run view, you can mimic the actions of the elevator using the keys 
described in the table on pages 27 and 28. 
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______________________________________________________________________ 
Up arrow  This will increase the scan slot by 1, set the travel 

graphic to up, and open the elevator doors. If you have 
reached the maximum scan slot, then no change will be 
made to the scan slot, and the travel graphic will be set 
to down. Using the up arrow will allow you to preview your 
floor based messages, floor based text, and travel graphic 
displays. 

______________________________________________________________________ 
Down arrow This will decrease the scan slot by 1, set the travel 

graphic to down, and open the elevator doors. If you have 
reached the minimum scan slot, then no change will be 
made to the scan slot, and the travel graphic will be set 
to up. This will also allow you to preview floor based 
messages, floor based text, and travel graphic displays. 

______________________________________________________________________ 
Page Up  This is used to preview priority messages. It will increase 

the priority number from 1 to 8, and the corresponding 
priority floor messages will display. 

______________________________________________________________________ 
Page Down  This is also used to preview priority messages. It will 

decrease the priority number from 8 to 1, and the 
corresponding priority floor messages will display. 

______________________________________________________________________ 
O  This will simulate the elevator doors as open. Floor based 

messages only display when a door is open. 
______________________________________________________________________ 
 
C  This will simulate the elevator doors as closed. Time 

messages will override floor based messages if the 
elevator doors are closed. 

______________________________________________________________________ 
Space  This will advance to the next valid time message, provided 

that no floor messages exist, or that the doors are 
closed.  

______________________________________________________________________ 
Right arrow This will advance to the next time message, whether or 

not it is valid (within the time it is scheduled to appear). 
______________________________________________________________________ 
Left arrow  This will move to the previous time message, whether or 

not it is valid (within the time it is scheduled to appear). 
______________________________________________________________________ 
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______________________________________________________________________ 
End Key    Decreases the Temperature 
______________________________________________________________________ 
Home Key   Increases the Temperature 
______________________________________________________________________ 
F  Toggles if the Arrival Signal will be active when the 

Elevator Door is open. This is used to test the Hall Arrival 
Arrow.  

______________________________________________________________________ 
A  Make so any changes to floor position will happen for all 

cars in a multi-car design.   
______________________________________________________________________ 
1 – 8   Use to select which car’s data will change in a multi-car 

design.  
______________________________________________________________________ 
N        Toggle the Sample Channeling message on and off.  
______________________________________________________________________ 
R        Toggle the Sample Real Time Full screen message on and off 
 
______________________________________________________________________ 
H        Toggle the Sample Real Time Half screen message on and off 
______________________________________________________________________ 
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